Intelligent Devices
DeviceTester
User Guide
# TABLE OF CONTENTS

## INTRODUCING DEVICETESTER
- ABOUT DEVICETESTER
- NTCP TIME CALCULATOR
- DYNAMIC MESSAGE SIGN SIMULATOR
- RESEQUENCE MASTER TABLES
- CONFORMANCE GROUP ITEMS
- CONFORMANCE GROUPS
- IMPORT MIBS
- CONFORMANCE GROUP ITEMS
- IMPORT MIBS
- EXPAND MASTER TABLES
- MAKE MASTER TABLES
- EDIT MASTER TABLES
- RESEQUENCE MASTER TABLES
- DYNAMIC MESSAGE SIGN SIMULATOR
- NTCP TIME CALCULATOR

## DEVICES
- EASYTEST
- SCRIPT BUILDER
- ADVANCED TEST
- STMP AND SFMP
- FSOR
- DEVICES
- DEVICE TYPES
- CONNECTIONS

## TOOLS
- ZOOM
- TEST OPTIONS
- CONFORMANCE GROUPS
- CONFORMANCE GROUP ITEMS
- IMPORT MIBS
- EXPAND MASTER TABLES
- MAKE MASTER TABLES
- EDIT MASTER TABLES
- RESEQUENCE MASTER TABLES
- DYNAMIC MESSAGE SIGN SIMULATOR
- NTCP TIME CALCULATOR

## HELP
- DEVICE TESTER HELP
- ABOUT DEVICE TESTER

## HOW TO IMPORT A MIB INTO DEVICETESTER

## INDEX
INTRODUCING DEVICETESTER

DeviceTester is an easy to use, powerful, and convenient way to test device conformance to an NTCIP suite of standards. It automatically checks all the device OIDs, performs error simulation, and creates complete result logs and reports. In addition to testing devices, DeviceTester is an exceptional tool for fault finding during acceptance testing and when the device is in operation.

With DeviceTester, you can:

- Debug new applications and products.
- Fault find during system integration and acceptance testing
- Build custom object lists for peripheral device specification, and then test only those objects.
- Add manufacturer specific objects and test both central and field device support.
- Import ASN.1 Management Information Bases (MIBs) for easy processing.
- Verify Conformance Group and object support for contract compliance.
- Print complete reports for documented test record.

DeviceTester supports multiple devices, multiple device types, and standard or custom object master tables. The following master tables are included in DeviceTester:

- 1201 – Global Objects
- 1202 – Actuated Signal Controllers
- 1203 – Dynamic Message Signs
- 1204 – Environmental Sensor Stations
- 1205 – CCTV Camera Control
- 1209 – Transportation Sensor Systems

Additional Objects can be imported from any valid MIB file.

DeviceTester supports the following Protocol Stacks as standard:

- Direct connect multi-drop
  Data Objects → SNMP → Null → PMPP → Twisted Pair
- Dial Up
  Data Objects → SNMP → Null → PMPP → V Series Modem → Telco
- Network / Internet / Connection based
  Data Objects → SNMP → TCP/IP → Ethernet → Twisted Pair
- Network / Internet / Connectionless
  Data Objects → SNMP → UDP/IP → Ethernet → Twisted Pair
INSTALLING DEVICETESTER

1. Insert the CD into the CD-ROM drive.
2. Select **Start**.
3. Select **Run**.
4. Select **Browse**.
5. Select the **CD-ROM drive** from the ‘Look In’ drop down list.

**Note:** If Microsoft Access version 2000 or later is installed, DeviceTester may be installed without Access Runtime. If a prior version of Microsoft Access is installed or Microsoft Access is not installed, then DeviceTester must be installed with Access Runtime.

**Installing without Access Runtime:**
1. Select the **NoRuntime** folder.
2. Select **Setup**, and click the **Open** button.
3. Follow the on screen prompts.

**Installing with Access Runtime:**
1. Select the **Runtime** folder.
2. Select **Setup**, and click the **Open** button.
3. Follow the on screen prompts.

**After Installing DeviceTester:**
1. Select **Tools** from the Menu bar.
2. Select the **Make Master Table** menu item.
3. Click the ↓ (down) arrow at the option **Source Master Table**.

**Note:** If a list of Tables does not appear, **MDAC_typ version 2.7** (included on the CD) must be installed.

**To Install MDAC_typ version 2.7:**
1. Navigate to the **MDAC** folder.
2. Double click on the **MDAC_typ 2.7 refresh.exe** icon.
3. Follow the on screen instructions.

**Removing DeviceTester and Access Runtime (if installed):**
1. Select **Start**.
2. Select **Settings**.
3. Select **Control Panel**.
4. Select **Add/Remove Programs**.
5. Select the **Install/Uninstall** tab.
6. Locate **DeviceTesterforNTCIP** in the box and select it.
7. Click the **Add/Remove** button, and then select **Yes** to remove the program and all of its components.
STARTING DEVICETESTER

To start DeviceTester, click on the shortcut on the desktop. The DeviceTester icon looks like this:

![DeviceTester icon](DeviceTesterForNTCIP.png)

The switchboard will appear:

![DeviceTester switchboard](DeviceTesterForNTCIP.png)

Select from the main menu (File, Device, Tools, Help) to begin using DeviceTester.
MAIN MENU BAR FUNCTIONS

The main menu consists of the following options:

- File
- Device
- Tools
- Help

File

The File menu consists of the following options:

- Reports
- Exports
- Import Scripts
- Backup Tables
- Restore Tables
- Exit

Reports

The Reports screen allows you to print or preview available Reports.

The Reports dialog enables pre-formatted reports to be generated from available log tables. Reports can be previewed or printed.
Log tables will exist only if one or more of the Log options have been enabled in the Options dialog prior to running tests. See the section Tools ➔ Test Options for more information on setting up the contents of log tables.

- Auto Test Log Report - displays object values associated with running an AutoTest from EasyTest.
- Test Log with Hex Dump - displays hexadecimal communications traffic associated with get and set operations between DeviceTester and devices. This log report is enabled automatically when one or more of the log options is enabled.

Exports

The Export function allows DeviceTester data to be exported in a format useable by other applications. Exported data, with the exception of scripts, is not intended to be re-imported into DeviceTester. If the exported data is re-imported into DeviceTester it will be added to the database but will not be accessible. Doing this will cause unnecessary "bloating" of the database.

The available export formats are:

1) Access database (.mdb)
2) Excel spreadsheet (.xls)
3) XML file (.xml)
4) Text file (.txt)

The Export command only exports data from fields normally displayed within DeviceTester windows. It does not export data from fields that are used internally to manage the tables. Therefore, Export is not to be used to prepare backups for later restoration since the exported tables do not contain all the fields required internally by DeviceTester to perform a complete restoration. To make backups, use the Backup Tables menu function described later in this manual. One exception exists: Scripts may be exported for later import with the Import Script command available on the file menu.

The export dialog makes it possible to select an entire table or subsets of a table to export by filtering the internal contents of tables by name. For example, selecting the Scripts option displays a list of all the individual scripts currently loaded into the operating environment. More scripts may be available on disk, but only those "loaded" at the present time are displayed in the list. Of those scripts displayed in the list, only those individually selected by mouse click will be exported. The Export button is disabled until at least one selection is made.
Choose the item to be exported from the Export Selections list. Six options are available:

- **Log File**
  - Exports the entire contents of the internal log file. A list of dates is displayed for the records kept in the log file. A range of dates must be selected to enable exports.

- **Scripts**
  - Exports scripts currently loaded into the environment. The list of scripts currently loaded is displayed. Each script to be exported must be individually selected.

- **Device Data**
  - Exports a list of the object data stored for a device. The exported table will be indexed by OID, object name, and object instance.

- **Master Tables**
  - Exports the MIB data for all objects maintained within a Master Table.

- **Connections**
  - Exports a table of all the devices using the selected connection type. A list of all available connection types is displayed. Exports a table of all of the devices currently using the selected connection type.

- **Conformance Group**
  - Exports a Master Table of the objects in the conformance group.

Select the data to be exported and then highlight the items that are to be exported. Then click the Export option. This action will open a dialogue box. Select in which of the four available formats the selected data should be saved. The valid formats are:

- Text Files (.txt)
- Excel Files (.xls)
• XML Files (.xml)
• Access Database (.mdb)

WARNING: The Export file format between Versions 1.41 and 1.54 has changed and they are not compatible. Phone (770) 831-3370 for support to recover scripts exported with Version 1.41.

Import Scripts

The Import Scripts option provides a convenient mechanism for importing scripts into the current operating environment. Scripts are stored in database files and include scripts supplied with the program or those created by the user. Standard scripts may be modified by the user and then saved to disk using the Export command discussed earlier.

Please be aware that the scripts currently loaded in the operating environment will be permanently destroyed by importing other scripts. To preserve any current scripts, export those scripts before importing other scripts.

After scripts are loaded in the system, any changes made to them are temporarily stored internally. Therefore it is not necessary to export scripts every time a change is made. It is only necessary to export scripts before importing other scripts. When scripts are imported a copy of the script is made and stored internally within DeviceTester.

When new scripts are imported, you have the option to delete all the existing scripts, or to append the new scripts to the scripts currently loaded. To delete the existing scripts, select ‘YES’. (Make sure that you have exported any scripts that you want to save as all the currently loaded scripts will be deleted!) To append the new scripts to the existing list, select ‘NO’. If any new script numbers are the same as an existing script number, you will be prompted to provide a new name. All scripting steps will be renumbered and the script appended to the list.

Scripts are stored in Access (.mdb) or Text (.txt) format.

Backup Tables

The Backup Tables command is a mechanism for extracting and storing internal data tables. Unlike the export command, which extracts only a subset of the data within tables, the Backup Tables command extracts and stores the entire content of the internal tables. Backup Tables is intended primarily to prepare DeviceTester for product updates. During the normal course of using the program, master tables, devices, device types, scripts, etc. are created and stored internally within the DeviceTester database. When a product update is issued, the existing DeviceTester database, including all user data created within that database, is replaced by the new database in the update. Unless a backup of the tables stored within the current DeviceTester database file is made prior to performing the installation of the update, all the work performed since the previous installation of the software will be lost.
When the Backup Tables command is invoked, a dialog box appears displaying a list of all the tables stored internally within the DeviceTester database. Tables in the list may be selected individually, or the entire list may be selected by selecting the first table in the list by mouse click, pulling the slider bar to the bottom and clicking the last table in the list while holding down the Shift key.

To prepare DeviceTester for a product update, select the entire set of tables in the list. Click the Backup button. A standard explorer dialog will then appear.

Type a name for the backup database and select a place to store the file. Click Save to create the backup database file. Click the Cancel to complete the operation.

**Restore Tables**

The Restore Tables command imports tables previously saved with the Backup command. Selection of the Restore Tables command displays an Explorer dialog window. Navigate to the location on disk where the backup Access database file (.mdb) is stored. Select the backup file and click Open. DeviceTester will then display a list of all the tables stored within
the database file. To restore the entire contents of the backup file into DeviceTester’s internal database, use the following selection method to select all of the tables in the list:

- Click first → Hold Shift→Click last.

Click the Restore button to import the contents of the backup file into DeviceTester. Click Cancel once the operation is complete.

Exit

Use this option to exit DeviceTester.
Device

The Device menu consists of the following options:

- EasyTest
- ScriptBuilder
- Advanced Test
- STMP and SFMP
- FSOR Test
- Devices
- Device Types
- Connections

**EasyTest**

The EasyTest form is the most basic of the DeviceTester activity forms. This form enables users to work with individual devices and individual objects within devices. The form displays attribute information pertaining to devices and objects and allows access to object values. The form also displays status information about connection activity, provides the ability to save object values to the database, and to log device activity for later display in reports.

The following form elements will be discussed in this section:

1. Device under Test
2. Test OIDs As (object list filter options)
3. Object Test List
4. Object under Test
5. Communication Status
6. AutoTest
7. Value Format (ASCII or Hex)
8. Activity Field
9. Test Information Fields

Quick Start

At its most basic level, working with devices through EasyTest is a simple three-step process:

1. Select a device from the device list.
2. Double-click an item in the Object Test List to select an object within the device.
3. Click one of the four Set or Get buttons to send an object value to, or retrieve an object value from the database or device.

The remainder of this section will discuss the usage of specific elements on the EasyTest form.
Select Device To Test

The drop down box in the upper left displays the device list and enables the selection of a device. Once a device is selected from the list, the following actions occur:

1. The object list filters are enabled.

   By default, when a device is selected, the Individual OIDs option in the Test OIDs As section is selected. The Individual OIDs option applies no filter to the device objects. Consequently, all device objects are inserted into the Object Test List for selection.

2. The objects within the current filter are inserted into the Object Test List for selection.

   The objects displayed in the Object Test List must be double-clicked for selection. Once selected, the object value from the database is automatically inserted into the Value field at the bottom center of the Object under Test section.

3. A connection to the device under test is established.

   If the connection type is setup to be a client of the device, a connection is automatically established with the device. (In client/server terms, the field device is the server and DeviceTester is the client.) However, if the connection type for the device is setup to be a TCP/IP server, once the device is selected, the device will wait until a client attempts to connect to it. The TCP/IP server will wait for the time period specified in the timeout parameter for the connection type before aborting the connection attempt. For a TCP/IP server, the connection order is important. The server must be started first and wait for a client to connect second. If the client is started first and the server second, a connection will not be established.
4. A link to the device data table is established.

   As discussed in the Devices section of the manual, each device upon creation contains its own hidden table of object values for each object within the device. The object value tables are oftentimes collectively referred to as ‘the database’ within this manual. Device selection enables the association between device objects and device object values, and enables values to be either retrieved from or written to the object value tables for devices.

5. The device attributes are displayed.

   The device attributes are displayed in read-only fields. Changes to device attributes can only be accomplished from the Devices form under the Device menu option. If a device attribute is changed while a device is actively selected in EasyTest, the device must be re-selected from the device list in order for the change to take effect.

Community
The Community Name is the SNMP community name. By default it is “public”. It may be changed to any name between 6 and 16 characters and is case sensitive.

Test OIDs As (Object Filters)
The option buttons in this section enable device object lists to be filtered by conformance group. Three filter options are available:

1. Individual OIDs

   All objects within a device are inserted into the Object Test List and are available for selection. This option also inserts non-accessible objects into the list even though non-accessible objects do not support values and cannot be accessed in any way.

2. Conformance Group

   Only those objects defined to be a member of a selected conformance group are inserted into the Object Test List. This option enables the two conformance group drop down lists immediately to the right of the option button. The first drop down list displays a list of the device types within DeviceTester. The second drop down list displays the conformance groups defined within a device type. If a conformance group name is known, the filter may be more quickly applied by typing the name of the group directly into the drop down list field. Since auto completion is enabled for the drop down list, typing just the first few letters of the name usually brings the name into the list very quickly.

3. All Device OIDs

   This option is identical to the Individual OIDs option, but it additionally enables AutoTest, which is a mechanism for performing automatic sequential operations on sets of objects. The AutoTest options will be discussed more thoroughly later in this section.
Object Test List
The Object Test List displays the set of objects filtered by the filter options. If no filter is applied, all objects contained within a device are shown. If a filter is applied, only those objects contained within the filter subset are displayed (typically a conformance group).

The Object Test List is the selection location for device objects. Selection occurs by double-clicking an object within the list. Only one object may be selected at a time. (To select multiple objects, use Advanced Test.) Once an object is selected, all of the attributes for the selected object are displayed in the fields within the Object Under Test section immediately to the right of the Object Test List.

Selection of an object automatically inserts the object value from the database for the device into the Value field. The background color of the Value field turns yellow. If no value exists within the database for the selected object, then no value appears within the Value window.

The objects in the list are lexicographically ordered as they are in the MIB for the device. All individual instances of objects are shown. Instances of table objects are also individually listed.

Object Under Test
The Object Under Test section displays all of the attributes associated with an object. The fields are for information only and cannot be edited. To edit the individual attributes of an object, go to Tools → Edit Master Tables.

Beneath the attribute fields are four action buttons and a Value field. The Value field displays an object value in either text/decimal or hexadecimal format. By default, values are displayed in text/decimal format unless the Hex option button in the lower right is selected.

Four action buttons enable manipulation of object values. Values may be either sent to or retrieved from the database or field device. The Get From Database and Set To Database buttons move object values between the Value field and the database. The background color of the field turns yellow when values are moved between the Value field and the database. The Get From Device and Set To Device buttons move object values between the Value field and the device. The background of the Value field turns pale blue when values are moved between the Value field and a device.

Two typical operations are to get a value from the database then set the value to the device, and to get a value from a device then set the value to the database. Once a value is placed into the database, it remains there until it is overwritten. If a value is too large to be displayed within the Value field, a larger display box is opened above the buttons, and the value is displayed in the larger box up to 256 characters maximum.

Communication Status
When a “get” from or a “set” to the device is performed, the Communications Status window will display a visual indication of the communication.

A green flash will be displayed in the transmit box when a packet of data is transmitted to the device.
A green flash will be displayed in the receive box when a packet of data is received from the device.

A yellow flash will be displayed in the wait box when a timer is running and the system is waiting.

A red flash will be displayed in the error box when the transmission fails or a bad packet of data has been transmitted or received. The actual text of the error message will be displayed in the Activity field situated below the Object Test List box.

**Value**
This field displays the value associated with the selected object for a particular device.

If the background color of the field is yellow, that value is the value that is contained in the database. If the background color is pale blue, the value was retrieved or sent to the device. If the value that is retrieved or sent to the database or device is too large for the value field, the value field will automatically open in a larger window above the get and set buttons, so that you can view the entire field.

**Activity**
This field displays the status of the last communication event. If the entire line of commentary does not display in the window, highlight that line and select Zoom from the Tools Menu.

**Test Number**
A specific test number can be entered for each test. This reference number does not replace the script number but can be used in addition to it. It is an optional field. This field will be printed on the reports.

**Test Name**
The test name is the name given to the test being performed. This name is recorded in the log file. When printed, files will be grouped together by test name and number.

**Test Witness**
If a script for a test that is to be witnessed by a third party is running, enter that persons name in this field. It is an optional field, and will be printed on the script reports.

**Start Auto Test**
This button will start the AutoTest utility. Define the parameters for the AutoTest before starting the test. The options for the AutoTest are located by clicking the Options button and selecting the AutoTest Configuration tab.

AutoTest will run according to the options selected until it is complete or until the Stop Auto button is clicked.

**Stop Auto Test**
Use this option to stop the AutoTest utility. When this button is clicked, the test will stop and a message to that effect will be displayed in the Activity window.
**Value Format (ASCII or Hex)**
The ASCII/Dec and Hex option buttons regulate the display format of object values within the Value field. By default, the ASCII/Dec option is enabled. The ASCII/Dec option displays numeric values in decimal and text as printable characters. The Hex option converts all characters to their equivalent hexadecimal representation. The hex option is especially useful for examining values that incorporate non-printable characters, such as those between 0 and 31 (inclusive) on the ASCII chart.

**Options**
The Options utility allows the selection of options for testing and logging the tests. AutoTest Configuration allows for the selection of the type of test that is to be performed. Log Configuration allows for the specification of the contents and size of the Log File that is generated by the system during a test. Test Defaults allows for the specification of the steps that should be taken when an error is encountered and how long to wait between tests and for a response.

**Get From Database**
To retrieve the value for a particular OID from the database, select that OID from the Object Test List by double clicking on that OID and then click the Get From Database button. The value that is stored in the database for that OID will be displayed in the Value box. The background color of the Value box will be changed to yellow, indicating that the value displayed is from the Database.

If the value that you receive from the database is too large for the Value display box, a larger display box will be opened above the get and set buttons, allowing you to view the entire Value field.

**Set To Database**
To update the database with a particular value for an OID, first select that OID from the Object Test List by double clicking on that OID. Then enter the value that is to be sent to the database in the Value box and click on the Set To Database button. The background color of the value box will be changed to yellow, indicating that the value displayed is from the database.

**Get From Device**
To retrieve the value for a particular OID from the device, select that OID from the Object Test List by double clicking on that OID and then clicking the Get From Device button. The value that is stored in the database for that OID will be displayed in the Value box. The background color of the Value box will be changed to pale blue, indicating that the value displayed is from the device.

**Set To Device**
To update the device with a particular value for an OID, first select that OID from the Object Test List by double clicking on that OID. Enter the Value that is to be sent to the device in the Value box and click on the Set To Device button. The background color of the value box will be changed to pale blue, indicating that the value displayed is from the device.
Script Builder

This screen allows you to create or “build” Scripts (series of tests or commands grouped together that can be executed one by one).

Community
The Community Name is the SNMP Community Name. By default, it is “public”. It may be changed to any name between 6 and 16 characters and is case sensitive. Therefore, if you enter “Public” you will not be able to communicate with a device set for “public”.

Select Device
Select the device that contains the OIDs that are being tested. If the device being tested does not appear in the drop down list box, add that device.

Once the device has been selected, the details for that device (Device Type Name, Device Address, Connection Type and Device Description) will appear in the fields below. This will allow you to check that the correct device has been selected. Note that the device details cannot be changed on this form. Device details are created or edited on the device form.

All the Objects supported by the device will be listed in the Object Test List.

Run Script
This will run the currently selected Script. It will run through the entire Script until the last line of the Script is reached or the Stop Script button is activated. If the “Halt After Running to End of
List” option is checked on the Test Options form under Tools, the test will only run once. If the option is not checked, the test will start again at the beginning of the Test when the end of the Test is reached and will continue until the Stop Script button is pressed.

**Single Step**
This will run through the currently selected Script, line by line. Each time the Single Step button is clicked, the next line of the Script will be actioned.

**Stop Script**
Use this button to stop the Script that is currently running.

**Options**
The Options utility allows the selection of options for testing and logging the tests. AutoTest Configuration allows the selection of the type of test that is to be performed. Log Configuration allows you to specify the contents and size of the log file that is generated by the system during a test. Test Defaults allows the specification of the steps that should be taken when an error is encountered and how long to wait between tests and for a response.

**Script Number**
Each script that is created will have its own unique identifying number. When a new script is created, the next available sequential number is allocated to the new script.

This number cannot be edited. If a script is deleted, the script number for the deleted script will not be reused unless it was the last number in the script series.

**Script Name**
The Script Name will identify which script is active. The name should be as meaningful as possible so that a script can be easily identified. This is an optional field, and will be printed on the script reports.

Each script is made up of a number of script details, which record all the actions you wish to perform in a script.

**Test Number**
A specific Test Number can be entered for each test. This reference number does not replace the Script Number but can be used in addition to it. It is an optional field. This field will be printed on the script reports.

**Test Witness**
If a Script is running for a test that is to be witnessed by a third party, that persons Name can be entered in this field. It is an optional field, and will be printed on the script reports.

**Script Description**
This is a brief description of the script that you are entering or have selected. This field will be printed on the script reports.

**Navigate Scripts**
The Navigate Scripts buttons allow the adding of new scripts and the editing or deleting of existing scripts.
To add a new script, click on the New button. The next sequential script number will be allocated to the new script. If you use the New button, the script that is created will be added as the last script on file.

To insert a script in a particular place in the list of scripts, use the previous and next arrow buttons to scroll to the script number of the script before which you want the new script inserted. Click on the insert button and the new script will be inserted and the existing script numbers will be adjusted accordingly.

To delete an existing script, use the previous and next record arrow buttons to scroll to the record that is to be deleted. When the script that is to be deleted is located, click on the delete button and that script will be deleted.

**Record Of Scripts**
This indicates which database record you are displaying. Each script that you create is stored as a record on the database. These fields can be used to see how many scripts are stored in the database.

**Activity**
This field displays the status of the last communication event. If the entire line of commentary does not display in the window, highlight that line and select Zoom from the Tools Menu.

**Clear Activity**
Press the Clear Activity button at any time to clear out the information in the Activity List Box.

**Script Detail**
Use the Script Detail fields to view, add, edit or delete each line of the selected script. Each line of the script can be displayed in the field boxes for editing purpose.

**Line Number**
Each line of the Script has its own unique Line Number allocated automatically by the system. If you delete a line of a Script, that Line Number will be erased. That Line Number will only be re-used if you choose to insert a new line in its place. To do this, position the cursor on the line preceding the erased line and click the insert button. A new line will be created using the deleted Line Number.

**Select Function**
Each line of a Script will perform a particular function. Select the required function from the drop down list. Each function has a corresponding set of properties that you will need to enter for that function. The appropriate property fields will be displayed for each function.

**WARNING:** If an existing script containing jump instructions such as RunScript, GoToLine, or If-Then_Else is imported and appended to an existing collection of scripts, the line numbers referenced by the jump command will not be automatically adjusted and must be adjusted manually.
The valid functions are:

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameters</th>
<th>Function</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>NoOperation</td>
<td>None</td>
<td>Decrement Value</td>
<td>Select Variable</td>
</tr>
<tr>
<td>Get</td>
<td>Select OID (note 1)</td>
<td>SetFromVariable</td>
<td>Select OID</td>
</tr>
<tr>
<td></td>
<td>Select OID Name (note 1)</td>
<td></td>
<td>Select OID Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Select Value Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Select Variable</td>
</tr>
<tr>
<td></td>
<td>Set Select OID</td>
<td>If…Then…Else</td>
<td>Select Variable</td>
</tr>
<tr>
<td></td>
<td>Select OID Name</td>
<td></td>
<td>Select Operator</td>
</tr>
<tr>
<td></td>
<td>Select Value Type</td>
<td></td>
<td>Compare Value</td>
</tr>
<tr>
<td></td>
<td>Value To Set</td>
<td></td>
<td>True Then go To Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Else Go To Line</td>
</tr>
<tr>
<td>GetNext</td>
<td>None</td>
<td>Asclnc (note 3)</td>
<td>Select Variable</td>
</tr>
<tr>
<td>GetAndSaveToDatabase</td>
<td>Select OID (note 1)</td>
<td>AscDec (note 3)</td>
<td>Select Variable</td>
</tr>
<tr>
<td></td>
<td>Select OID Name (note 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetFromDatabase</td>
<td>Select OID (note 1)</td>
<td>Copyvar</td>
<td>Copy From Copy To</td>
</tr>
<tr>
<td></td>
<td>Select OID Name (note 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay</td>
<td>Seconds</td>
<td>ConcatVar (note 4)</td>
<td>To Append Result</td>
</tr>
<tr>
<td>MsgBoxOK</td>
<td>Prompt</td>
<td>GetTableEntry(Var) (note 5)</td>
<td>Index 1 Index 2 Index 3 Index 4 Index 5 Index 6 Save To Base OID</td>
</tr>
<tr>
<td>MsgBoxPassFail</td>
<td>Prompt</td>
<td>Compare Variables</td>
<td>Select 1st Var</td>
</tr>
<tr>
<td>MsgBoxYesNo</td>
<td>Prompt</td>
<td>ActivateMessage</td>
<td>Select Operator</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Select 2nd Var</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>True Go To Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>False Go To Line</td>
</tr>
<tr>
<td>GoToLine</td>
<td>Line Number</td>
<td>ActivateMsg(Var)</td>
<td>Duration</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Memory Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Msg Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MsgCRC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IP Address</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## MAIN MENU BAR FUNCTIONS

<table>
<thead>
<tr>
<th>RunScript</th>
<th>Line Number</th>
<th>Download Message</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Select Message</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Memory type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Msg Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MULTI Message</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SetVariable</th>
<th>Select Variable</th>
<th>DownloadMsg(Var)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Value To Set</td>
<td>Mem Type Var</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Msg Number Var</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MULTI Message Var</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SetFromVariable</th>
<th>Select OID</th>
<th>SetPositionReference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select OID Name</td>
<td>Select OID</td>
</tr>
<tr>
<td></td>
<td>Select Value Type</td>
<td>Select OID Name</td>
</tr>
<tr>
<td></td>
<td>Select Variable</td>
<td>Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pos or Offset</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GetPositionReference</th>
<th>Select OID</th>
<th>GetPositionReference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select OID</td>
<td>Select OID</td>
</tr>
<tr>
<td></td>
<td>Select OID Name</td>
<td>Select OID Name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GetAndSaveToVariable</th>
<th>Select OID (note 1)</th>
<th>SetHexValue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select OID Name(note 1)</td>
<td>Select OID</td>
</tr>
<tr>
<td></td>
<td>Select variable</td>
<td>Select OID Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select Value Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value to Set</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IncrementVariable</th>
<th>Select Variable</th>
</tr>
</thead>
</table>

### Notes:

1. Select either by OID or by OID name. The system will synchronize the OID and the name, irrespective of which one was selected.

2. These options work only with numbers.

3. This option converts the first character of the variable to its ASCII code, increments or decrements it, depending on the selection, and converts it back to decimal.

4. This function appends one variable to another and saves the result in the third variable.

5. This function allows you to access instances of an object within a table by assigning indexes to variables. A combination of set variable, increment variable and/or goto can be used to make scripts cycle through (enumerate) multiple instances of that object. (Specifically used to get the DMS CRC).

6. This option prepares the dmsActivateMessage Object in the correct form, based on the variables selected.

### Description

Enter a free format description of the specific details of the function being performed by each line of a script. This entry will be printed on the script report. You can navigate through script detail using the ↑ ↓ keys located on the screen. The information on the script line description is saved when on moving to the next field.
**Navigate Script Details**

The Navigate Script Details buttons allow the adding of new scripts and editing or deleting existing scripts.

To add a new script, click on the New button. The next sequential script number will be allocated to the new script. If you use the New button, the script that is created will be added as the last script on file.

To insert a script in a particular place in the list of scripts, use the previous and next arrow buttons to scroll to the Script Number of the script before which you want the new script inserted. Click on the insert button and the new script will be inserted and the existing script numbers will be adjusted accordingly.

To delete an existing script, use the previous and next record arrow buttons to scroll to the record that is to be deleted. When the script that is to be deleted is highlighted, click on the delete button and that script will be deleted.

**Record Of Scripts**

This indicates which database record is being displayed. Each script that you create is stored as a record in the database. Use these fields to see how many scripts are stored in the database.
Advanced Test

The Advanced Test form enables users to work with group devices and group objects within devices. The form displays attribute information about devices and objects and enables working with object values. The form also displays status information about connection activity, provides the ability to save object values to the database, and to log device activity for later display in reports.

The following form elements will be discussed in this section:

1. Device under Test
2. Test OIDs As (object list filter options)
3. Object Test List
4. Selected Objects Window
5. Communication Status
6. Value Format (ASCII or Hex)
7. Activity Field
8. Test Information Fields

Select Device To Test
The drop down box in the upper left displays the device list and enables the selection of a device. Once a device is selected from the list, the following actions occur:
1. The object list filters are enabled.

   By default when a device is selected, the Individual OIDs option in the Test OIDs As section is selected. The Individual OIDs option applies no filter to the device objects. Consequently, all device objects are inserted into the Object Test List for selection.

2. The objects within the current filter are inserted into the Object Test List for selection.

   The objects displayed in the Object Test List must be double-clicked for selection.

3. A connection to the device under test is established.

   If the connection type is setup to be a client of the device, a connection is automatically established with the device. (In client/server terms, the field device is the server and DeviceTester is the client.) However, if the connection type for the device is setup to be a TCP/IP server, once the device is selected, the device will wait until a client attempts to connect to it. The TCP/IP server will wait for the time period specified in the timeout parameter for the connection type before aborting the connection attempt. For a TCP/IP server, the connection order is important. The server must be started first and wait for a client to connect second. If the client is started first and the server second, a connection will not be established.

4. A link to the device data table is established.

   As discussed in the Devices section of the manual, each device upon creation contains its own hidden table of object values for each object within the device. The object value tables are oftentimes collectively referred to as ‘the database’ within this manual. Device selection enables the association between device objects and device object values, and enables values to be either retrieved from or written to the object value tables for devices.

5. The device attributes are displayed.

   The device attributes are displayed in read-only fields. Changes to device attributes can only be accomplished from the Devices form under the Device menu option. If a device attribute is changed while a device is actively selected in EasyTest, the device must be re-selected from the device list in order for the change to take effect.

Select the device that contains the OIDs that are to be tested. If the device that you are testing does not appear in the drop down list box, first add that device.

Once the device is selected, the details for that device (Device Type Name, Device Address, Connection Type and Device Description) will appear in the fields below.

All the objects supported by the device will be listed in the Object Test List.

**Group Address**

This sets the Group Address bit in the address byte of the PMPP wrapper. Note that to send an all stations broadcast address (0xFF) the Group Address box must be checked and the Device Address must be set as 63.
Source OID As
Depending on the device selected to test, choose to source the OID as:

- Individual OID
- Conformance Group OID

Get From Database
To retrieve the value for an OID from the database, select that OID from the Object Test List by double clicking on that OID and then click the Get From Database button. The value that is stored in the database for that OID will be displayed in the Value box. The background color of the Value box will change to yellow, indicating that the Value displayed is from the database.

If the value that you receive from the database is too large for the Value display box, a larger display box will be opened above the get and set buttons, allowing the entire Value field to be viewed.

Set To Database
To update the database with a particular value for an OID, first select that OID from the Object Test List by double clicking on that OID. Then enter the value that is to be sent to the database in the value box and click on the Set To Database button. The background color of the value box will change to yellow, indicating that the value displayed is from the database.

Get From Device
To retrieve the value for an OID from the device, select that OID from the Object Test List by double clicking on that OID and then click the Get From Device button. The value that is stored in the device for that OID will be displayed in the value box. The background color of the value box will change to pale blue, indicating that the value displayed is from the device.

Set To Device
To update the device with a particular value for an OID, first select that OID from the Object Test List by double clicking on that OID. Then enter the value that is to be sent to the device in the value box and click on the Set To Device button. The background color of the value box will change to pale blue, indicating that the value displayed is from the device.

Communication Status
When performing a “get” from or a “set” to the device, the Communication Status window will display a visual indication of the communication.

A green flash will be displayed in the Transmit box when a packet of data is transmitted to the device.

A green flash will be displayed in the Receive box when a packet of data is received from the device.

A yellow flash will be displayed in the Wait box when a timer is running and the system is waiting.
A red flash will be displayed in the Error box when the transmission fails or a bad packet of data has been transmitted or received. The actual text of the error message will be displayed in the Activity field situated below the Object Test List box.

**Sort By OID**
Check this box to sort the selected OIDs by OID Number, in hierarchical order. The default setting (unchecked) will keep the objects in the order in which they were selected.

**Options**
Select Options for testing and logging the tests. AutoTest Configuration allows selection of the Type of Test that is to be performed. Log Configuration allows specification of the contents and size of the log file that is generated by the system during a test. Test Defaults allows the specification of the steps that should be taken when an error is encountered and how long to wait between tests and for a response.

**Apply Value**
To change the value of an object, double click on that object and edit the value. Then click on the Apply value to apply that value change to the database.

**Activity**
This field displays the status of the last communication event. If the entire line of commentary does not display in the window, highlight that line and select Zoom from the Tools Menu.

**Selected Instance Objects**
The Selected Instance Objects box indicates how many objects have been selected for testing.

**Test Number**
A specific Test Number can be entered for each test. This reference number does not replace the script number but can be used in addition to it. It is an optional field. This field will be printed on the script reports.

**Test Witness**
If a script for a test that is to be witnessed by a third party is running, enter that persons name in this field. It is an optional field, and will be printed on the script reports.

**Test Name**
The Test Name is the name given to the test being performed. This name is recorded in the Log file.

**STMP and SFMP**
The Simple Transportation Management Protocol (STMP) and Simple Fixed Message Protocol (SFMP) Test option allows for the testing of dynamic objects and fixed messages. It also has an option for Simple Network Management Protocol (SNMP) Testing. The functionality of the SNMP is fundamentally the same as the Advanced Test utility and will not be covered in detail in this section of the manual.
STMP

STMP is used for efficient coding of multiple bindings. STMP (and DeviceTester) allows a maximum of 13 Dynamic Objects to be configured and tested.

Before STMP testing is used, the dynamic objects must be configured. DeviceTester includes a standard set of scripts for setting up dynamic objects for STMP testing. To view/edit these (and to create new ones) select ScriptBuilder and select the required Script. (The example script included with DeviceTester is called DynamicObjectSetUpScript.)

A device with Global and Dynamic objects pre-configured (called TestDynAndGlobal) is provided with DeviceTester. Use this to familiarize yourself with STMP and DeviceTester.

SFMP

SFMP testing is a simplified, more compact version of SNMP. If the device being tested supports SFMP, use this option to test the objects in that device.
To start an SFMP test, select the Device that is to be tested.

Check Encode Data as SFMP (Fixed).

Check the Conformance group check box and select the required conformance group if a specific conformance group item is being tested. If not, leave the check box blank.

Double click the object that is to be tested.

Select either Get from Database or Set to Database to retrieve or send the value from or to the database. To send or retrieve that data from the device, click on the required operation and click on the transmit button.

The data that is sent and retrieved from the database will be displayed in the Transmit Payload and/or the Receive Payload fields.
The Full Standard Object Range checking facility allows the checking of every valid value for any object in a device.

The drop down box in the upper left displays the device list and enables the selection of a device. Once a device is selected from the list, do the following:

1. Enable the object list filters.

   When a device is selected, only the objects with the Object Type that is checked will be listed in the Read/Write Object List box. Note that whatever the Object Type selected, only objects with read/write access will be displayed.

2. Select the Object for Test.

   The objects displayed in the Object Test List must be double-clicked for selection. Once an object is selected, the details for that object (Object Name, OID, OID Minimum, OID Maximum, OID Default and the OID Description) will be displayed in the fields adjacent to the Object List. If the object is a table entry, select the instance required for testing. If an instance is not selected, DeviceTester will use the first entry in the table.

3. Establish a connection to the device under test.

   Before establishing a connection, indicate by checking Extended Test or Condensed Test whether a full test of every value (Extended Test) is to be performed or if an abbreviated test (Condensed Test) should be run.
If Condensed Test is selected, enter the value by which each consecutive test value is to be incremented.

Click on Start to commence the test.

4. The Test Activity will be displayed, indicating the status of the test data.

In addition to the test activity, the communication status will be displayed in the Communication Status box, indicating whether the data is being transmitted or received, if the test is in wait mode or if an error has been encountered. The value being tested is displayed in the value window.

To stop the test before it has reached the end, click on the Stop Test button.

The results of the test will be recorded in the Log File if the Log File has been configured to record test results. To access this log file, click on the Options button. Select the Log Configuration tab and check that the configurations are correct.

**Devices**

A device is a grouping of a device type, a connection and device attributes. Such a device is a complex data structure created from, in part, the connections and device types data structures whose structures must exist prior to creating a device. In addition to the connection and device type properties, a device contains a Device Name, Device Address, Device Description and a set of device object data. These attributes characterize the device and make it distinguishable from other devices. The name, address and description are user-settable properties, while the object data is a hidden property.

In general, object data is a set of object values for all of the objects contained within a device. The objects contained within a device are maintained in a Master table. The master table contains a list of objects for a device, but the device maintains the values for those objects in the object data table. The Object Data Table maintains a one-for-one relationship with the objects in the Master Table, but does not change with the Master table, if the Master table should change. Consequently, if the Master table changes during the lifetime of a device, the device is no longer valid, even if it is still functional, since its data table no longer maintains synchronization with the Master Table.
Create Device

To create a new device, select values for Device Type Name and Connection from the drop down list boxes. If the Device Type Name and/or the Connection that is required does not display in the drop down list, add the Device Type Name and Connection. Device Types are added using the Device Type form and Connection details are added on the Connection Type form.

Enter the Device Name, Device Address and Device Description for the Device.

When all the information is complete, click on the Create New Device Button. This will set in motion the following procedures:

- A new Device Number is allocated.
- The Master Table for the selected Device Type is checked to ensure that it does not contain duplicate records.
- A Device Table is created, with records corresponding to the records in the Master Table. This creates a unique place to store the Device data, as well as a record of who last edited the data and when.
- The Device is added to the Device list. Whenever a drop down list for Device is displayed, the new Device will be included in it.

The relationship between Device, Device Types, Master Tables, MIBs, Connection Types etc., is graphically represented in the “Object Model”.

OBJECT MODEL

Testing and Control
**Device Type Name**
The Device Type Name is the descriptive name of the device that has been selected and is a means by which you can check that the correct device has been selected. Device Type Name is entered on the Device Type form. Select Device from the Main Menu and then Device Types.

**Device Name**
The name of the device is entered here. It is a free format field that is used to more fully describe the device being created.

**Connection**
Choose from the list the type of connection being specified.

**Device Address**
This is the only place that Device Address information can be added or edited. Any other occurrences of Device Address will be displayed as selection only fields, linked to the device that has been selected.

The Device Address is also referred to as the Drop Number, and is used to address the device when PMPP (Point to Multi Point Protocol) is used as the Transport Layer. When a network connection is used to connect a device, the Device Address must be set to 0 (not used) otherwise DeviceTester will return an incorrect address when packets are exchanged.

**Device Description**
This is the only place that Device Description information can be added or edited. Any other occurrences of Device Description will be displayed as selection only fields, linked to the device that has been selected.

**Delete Device**
If a particular device is no longer in use and should be removed from the database, select that device from the drop down list. Make sure that the details that display in the Device Number and Device Description fields are correct for the record that is to be deleted. Click on the Delete Existing Device and the record in the device table will be removed and the table with all the data for that device will be deleted.

**Delete Device Name**
Select the Device Name of the device that is to be deleted.

**Device Number**
The Device Number is a database control record and cannot be changed.

**Device Description**
Device Description is displayed for informational purposes only and cannot be edited here.

Click on the Delete Existing Device button to delete the selected device from the database.
Edit Device

To change information for an existing device, select that device using the Navigate Devices arrow buttons, until the device details for that device are displayed. Edit the required fields. Device Number is a database record number and cannot be changed. Select the required Device Type Name and Connection from the drop down list boxes attached to those fields. Enter the new details for Device Name, Device Address and/or Device Description. As soon as Enter is pressed after editing the field, that record will be updated. Do not re-enter data that is remaining the same.

Use the ◄ ► keys to navigate through available devices.

Device Type Name
The Device Type Name is the descriptive name of the Device Type that will appear in all drop down list boxes when a device type is required. The name should be as descriptive as possible to serve as a confirmation that the correct Device Type is selected when the list of Device Types is presented for selection purposes.

Device Type Name is entered on the Device Type form. Select Device from the Main Menu and then Device Types.

Device Name
The Name of the Device is displayed and can be edited here. It is a free format field that is used to more fully describe the Device being created.

Connection
Choose the type of Connection being specified from the list.

Device Address
The Device Address information can be edited here. Any other occurrences of Device Address will be displayed as selection only fields, linked to the device that has been selected.

Device Description
The Device Description can be edited here. Any other occurrences of Device Description will be displayed as selection only fields, linked to the device that has been selected.
Device Types

The Device Type screen is used to set up a template for a device.

**Device Type Name**
The Device Type Name is the descriptive name of the Device Type that will appear in all drop down list boxes when a Device Type is required. Make the name as descriptive as possible so that you can be absolutely sure that the correct Device Type is chosen when the list of Device Types is presented for selection purposes.

**Device Type Description**
The Device Type Description is used to describe the type of device.

**Device Type Master Table**
Each Device Type that is in the Device Type file must have a Master Table selected. A new Device Type record cannot be added without selecting a Master Table for that Device.

Open the drop down list box to select the Master Table. If the Master Table that is required is not displayed in the drop down list box, create that Master Table.

There are two methods that you can use to create a Master Table.

You can create a Master Table from original MIBs. Select Master Table Builder from the Tools option on the Main Menu. The alternative is to select Master Table Assembler from the Tools option on the Main Menu. This allows you to create a Master Table by selecting different Objects from existing Tables.

Use the ◄ ► keys to navigate through available the devices.

Click the New box to add a new Device Type.

Click the Delete box to delete an existing Device Type.
Connections

The Connections screen is used to set up a template for Connections.

Connection Name
The Connection Name is used to describe the Connection that is being specified.

Connection Description
The Connection Description is used to provide further information about the connection. This is not a mandatory field.

Connection Type
There are several different types of connections that can be established. The valid Connection Types are listed below:

Each Connection Type has a number of parameters attached to it. When a connection type is selected, the required input fields will be displayed so that the required parameters can be entered. The following table lists the available connection types, the parameters for that connection type and the valid entries for each parameter.
<table>
<thead>
<tr>
<th><strong>Connection Type</strong></th>
<th><strong>Parameters</strong></th>
<th><strong>Values</strong></th>
</tr>
</thead>
</table>
| Direct Connect      | Serial Port Number | Com 1  
|                     |               | Com 2  
|                     |               | Com 3  
|                     |               | Com 4  |
|                     | Baud Rate      | 1200  
|                     |               | 2400  
|                     |               | 4800  
|                     |               | 9600  
|                     |               | 19200 
|                     |               | 38400 
|                     |               | 57600 
|                     |               | 115200|
|                     | Data Bits      | Eight  
|                     |               | Seven |
|                     | Stop Bits      | 1 stop bit  
|                     |               | 1.5 stop bits  
|                     |               | 2 stop bits |
|                     | Parity         | None  
|                     |               | Odd  
|                     |               | Even  
|                     |               | Mark  
|                     |               | Space |
| Dial-up Connection  | Modem          | Modem 1  
|                     |               | Modem 2  
|                     |               | Modem 3  |
|                     | Telephone Number |          
| TCP/IP Client (Remote) | Server IP Address |          
|                     |               | Server Port Number |
| TCP/IP Server       | Server Port Number |          
| UDP/IP Client (Remote) | Server IP Address |          
|                     |               | Server Port Number |
| UDP/IP Server       | Server Port Number |          

If the Connection Type required is not available in the drop down list box from the Connection Type field, contact Intelligent Devices, Inc at (770) 831-3370.
When connection details are specified for a device, only the Connection Type is required. All other Connection details are specific to the Connection Type and can be reviewed or edited using the Entry/Edit for Connections form.

**Transport Type**

A Transport Type is a layer of communication within NTCIP Protocol Stacks.

A particular message transmission can use, at most, one standard at each level or sublevel of the NTCIP framework. The series of standards used in the message transmission is called a "stack" of standards, or a "protocol stack". It is possible for a pair of electronic devices to exchange some messages using one stack and other messages using a different stack, though usually, such stacks will differ only at one or two levels or sublevels. In Figure 3.3, optional standards at each level are shown by the lines connecting standards at different levels. If there is a continuous line (without reversal of direction) from one standard to another, then they are compatible and can be used together as part of a protocol stack.

**Time Out**

The value entered here indicates the number of seconds that should pass before an unsuccessful connection attempt is timed out.

Use the ► keys to navigate through available devices.

Click the New box to add a new Connection Type. Click the Delete box to delete an existing Connection Type.
Tools

The tools menu consists of the following options:
- Zoom
- Test Options
- Conformance Groups
- Conformance Group Items
- Import MIBs
- Expand Master Tables
- Make Master Tables
- Edit Master Tables
- Re-sequence Master Tables
- Dynamic Message Sign Simulator
- NTCIP Time Calculator
- Disconnect and Close Connection

Zoom

The Zoom function expands text that is not fully displayed. Place the cursor on the text to be viewed, then select Zoom from the tools menu item and text will shown in its entirety.

Test Options

The Test Options screen allows the output of a test to be customized.

Auto Test Configuration

The options selected here will determine the type of test that is to be performed by the AutoTest function. Tests can be performed using either the Send Only Good Packets of Data option, or the Send Only Bad Packets of Data option.
If the Send Only Good Packets option is selected, further selection of which test is to be performed must be made from the Select Good Packet Test list. Choose from:

- Get all Readable Values
- Get all Readable Values and Save to Database
- Get Next MIB Walk
- Set all Write Values to Minimum
- Set all Write Values to Maximum
- Set all Write Values to Database Value

If the Send Only Bad Packets option is selected, further selection of which test is to be performed must be made from the Select Bad Packet Test list. Choose from:

- Write to Read-Only
- Read Not-accessible
- Set Write Value Out of Range

**Log Configuration**
Specify the contents and size of the log file that is generated by the system when a test is performed. Choose to Log Error Events and/or Successful Events, and specify the Maximum Number of Events that are to be stored in the log.
Erase will clear the current log file and Resize allows the resizing of the log file.

**Test Defaults**
This option specifies whether the test should stop when an error is encountered during a test or if a test should stop only when the end of the test is reached. Also, specify the number of seconds to wait between tests and the number of seconds to wait for a response.
Conformance Groups

**Specification**
Each Conformance Group is derived from a particular specification. When a Conformance Group is added, indicate from which specification the group is derived.

When the drop down list is clicked, all the valid specifications will be listed. If the specification required is not included in the list, contact Intelligent Devices, Inc at (770) 831-3370.

**Conformance Group Name**
Enter the Name of the Conformance Group here. This name will appear in the drop down list box whenever Conformance Group is required displayed for entry.

**Conformance Group Items**

**Master Table Name For Objects**
Select the Master Table from which the Conformance Group item that is being added originates.
Conformance Group
The Conformance Group ID is a system-generated field and cannot be changed.

Conformance Item ID
This represents the record number of the Conformance Group Item. It is used for internal system procedures only.

Select Conformance Item Name
Select the Name of the Conformance Group for which an item is being added. If the Conformance Group Name does not appear in the list, add it using the Add Conformance Group option.

Import MIBs

A Master Table can be constructed using the original NEMA MIBs. Master Table Builder allows you to specify which MIBs should be imported into the Master Table that is being created.

Note that the first 5 MIBs that are listed in the Master Table Builder should always be selected for every Master Table is created. These basic NEMA MIBs will ensure that the OIDs in your Master Table commence at the correct starting value.

The SMIC MIB Compiler does have a size limitation. A compile failure may indicate that the limit has been exceeded. If this happens, deselect one or more of the MIBs that were selected and compile with fewer MIBs. Then create another Master Table using the “deselected” MIBs. When all the required MIBs have been added to a Master Table, and there is more than one Master Table, use the Master Table Assembler to merge those Master Tables into one.
Enter Or Select Master Table Name
Either select the Master Table from the list of existing Master Tables, or add a new Master Table Name for a new Master Table that is to be created.

Once this has been done, choose either to create a Master Table or delete that Master Table.

Create Master Table
This is one of two methods that can be used to create a new Master Table. The other is the Make Master Tables option, which is accessed from the Tools option on the Main Menu bar.

Delete Master Table
If a particular Master Table is no longer in use, that Master Table can be deleted.

Note that deleting a Master Table that is still used by a device will create "orphan devices" in the database that will cause errors if that device is selected for testing.

From the Import MIBs screen you may choose to navigate to other screens, including:

- Expand Master Table Rows
- Re-sequence Master Table Before Use
- Assemble Master Table
- Edit Master Table Detail Records

Expand Master Tables
The Master Table Expander is a utility that allows tables to be automatically expanded within a Master Table, depending on certain defined parameters.
Select Master Table Name
Click on the drop down list box and select the Master Table for which tables are to be created. The OIDs for that table will be displayed so that the OIDs that are to be expanded can be selected.

Item Objects
When selecting a table to expand, the number of objects for each instance of a table entry will be displayed here. This equates to the columns in the table.

Status
This indicates if there are any errors in the table entries.

Instances
Once the master for a particular table entry has been expanded, the number of instances that exist for that table will be displayed here.

Record Of Items
This indicates which record out of the entire file is the active (highlighted) record.

Create New Instances
When a table is expanded, the starting and ending values for any or all of the indexes required by that table can be specified. Before expanding the table, enter the “to” and “from” values for each of the indexes displayed.
**Expand Master Table**
Click on this button to expand the table using the parameters specified for the index values.

**Make Master Tables**
Use this function to assemble objects into a Master Table using other Master Tables.

**Source Master Table**
Select the Master Table from which OIDs are to be extracted. Only Master Tables that are included in the drop list box can be used.

**Target Master Table**
If OIDs are being added to an existing Master Table, select that existing Master Table from the drop down list box. If you are creating a completely new Master Table, enter the name of that Master Table here.

**Total Source Objects**
This indicates the total number of OIDs that are available for selection to the target master table.

**Total Target Objects**
This indicates the total number of OIDs that exist in the target master table selected or created.

**Filter By**
If only OIDs from a certain Conformance Group are required, the source OID can be filtered so that only the applicable OIDs are displayed for selection. In addition, only those OIDs that have an instance can be filtered.
If the default is set at None, the entire Source Master Table will be available for selection to the Target Master Table.

**Edit Master Tables**

![Edit OID window](Edit_OID.png)

Use this function to individually add or change an NTCIP Object.

**Entry For**
The Edit OID option allows editing of individual records in a Master Table. The Master Table is derived from existing MIBs. If the Master Table that is to be edited does not display in the drop down list box, that Master Table must be created before its OIDs can be edited.

The “Entry For” drop-down list displays all the Master Tables that have already been created. Select the one to edit and the first OID record will appear in the display boxes.

**OID**
The OID is the Object Identifier as defined in the MIB. The OID used in DeviceTester Master Tables is the full OID transmitted or received, and includes the OID and the instance.

If a new OID is being added, be sure to enter the entire OID string, ensuring that each sub-identifier in the string is separated with a period (.)
**OID Title**
The OID Title field will usually contain the same information as the OID Name field, but in a slightly different format. Use this field to further identify an OID or for foreign language information or basically any other purpose. It is currently not used anywhere else in the system.

**OID Name**
The OID Name is the Name that has been allocated to the OID in the MIB. The OID Name will be displayed whenever an OID is referenced in the system. The OID Name will generally be shown in the conventional “OID Name.Instance” format.

**OID Instance**
If the OID is instantiated, the instance number for the OID will be displayed here.

**Object Type**
Each OID has parameters. One of these parameters is Object Type and it categorizes the type of object. All the valid options will be displayed when the drop down list box is opened. If the type required does not appear in the drop down list box, it is not a valid type. Check your source and select one of the valid options.

The valid options for Object Types are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Type</td>
<td>Indicates that the OID has an Instance i.e. it can have a Value attached to it.</td>
</tr>
<tr>
<td>Object Identifier</td>
<td>Indicates that the OID is a node on the Object tree that does not have an Instance. This type of OID generally has the Access option set to “Not Accessible”, indicating that it cannot support a Value.</td>
</tr>
<tr>
<td>Table</td>
<td>Indicates that the OID(s) that follow are details for a Table that contains more than one Instance for the given OID. Index information for that Table is contained in the Row Type OID. The OID that follows a Table Type OID will be a Row Type.</td>
</tr>
<tr>
<td>Row</td>
<td>Indicates that the OID(s) that follow contain OID for one or more Instances for the Table and Row OID. The Instances that follow are equivalent to columns in a Table. Each Row will contain Index information. An Index is the parameter that is used to define the number and data required for each Instance of the OID. A Row can have more than one parameter (Index).</td>
</tr>
</tbody>
</table>

**Syntax Specific**
If the Object Syntax is specified as “Enum”, the specific value for that Object Syntax must be specified in the Syntax Specific field.

If there is no corresponding Syntax Specific data for an OID, this field should be left blank.
**Object Syntax**

Each OID has an Object Syntax allocated to it. This defines the abstract data structure corresponding to the Object. The valid options for Object Syntax are provided in the drop down list box attached to the field. These are the only valid options.

The valid options for Object Syntax are:

<table>
<thead>
<tr>
<th>Object Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTEGER</td>
<td>A simple type with distinguished values which are the positive and negative whole numbers, including 0.</td>
</tr>
<tr>
<td>OCTET STRING</td>
<td>A simple type whose distinguished values are in an ordered sequence of zero, one or more octets, each octet being an ordered sequence of 8 bits.</td>
</tr>
<tr>
<td>OBJECT IDENTIFIER</td>
<td>A value (distinguishable from all other such values) which is associated with an Object.</td>
</tr>
<tr>
<td>OBJECT DESCRIPTOR</td>
<td>A type whose distinguished values are human-readable text providing a brief Description of an Object.</td>
</tr>
<tr>
<td>ENUM</td>
<td>Simple type whose values are given distinct identifiers as part of the type notation.</td>
</tr>
<tr>
<td>SEQUENCE</td>
<td>Types defined by referencing an ordered list of types (some of which may be declared to be optional); each value of the Sequence Type is an ordered list of values, one from each Component Type.</td>
</tr>
<tr>
<td>REG POINT</td>
<td>A not accessible node in the OID tree.</td>
</tr>
<tr>
<td>GAUGE</td>
<td>Represents a non-negative integer, which may increase or decrease, but will never exceed a maximum value.</td>
</tr>
<tr>
<td>DISPLAYSTRING</td>
<td>Fundamentally the same as Octet String above except that it only allows ASCII printable characters.</td>
</tr>
<tr>
<td>OWNERSTRING</td>
<td>A Displaystring with a maximum number of 127 characters.</td>
</tr>
<tr>
<td>OPAQUE</td>
<td>Is provided solely for backward compatibility and should not be used for any newly defined Object Identifier.</td>
</tr>
<tr>
<td>COUNTER</td>
<td>Represents a non-negative integer that systematically increases until it reaches a maximum value, when it wraps around and starts again from zero.</td>
</tr>
</tbody>
</table>

**OID Minimum**

If the OID has a definite Minimum Value, that value must be entered here. This will ensure that if the OID Value that is present for the OID is less than the minimum entered here, that OID value would be rejected.
Object Access
Each object has an Object Access allocated to it, which is defined in the original MIB. It may be read and write, read only, non-accessible or write only.

<table>
<thead>
<tr>
<th>Object Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>read-write</td>
<td>Allow read and write access to the OID.</td>
</tr>
<tr>
<td>read only</td>
<td>Allow read only access to the OID.</td>
</tr>
<tr>
<td>Not accessible</td>
<td>The OID is not accessible.</td>
</tr>
</tbody>
</table>

OID Maximum
If the OID has a definite Maximum Value, that value must be entered here. This will ensure that if the OID Value that is present for the OID is greater than the maximum value entered here, that OID Value would be rejected.

Object Status
Each Object has an Object Status allocated to it. The status is defined in the original MIB. It may be mandatory, optional or deprecated.

<table>
<thead>
<tr>
<th>Object Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mandatory</td>
<td>Indicates that the OID has to be present for the Device.</td>
</tr>
<tr>
<td>Optional</td>
<td>Indicates that the OID may be present if required.</td>
</tr>
<tr>
<td>deprecated</td>
<td>Indicates that the OID is marked for obsolescence and should not be included in new specifications. It is required for legacy support.</td>
</tr>
</tbody>
</table>

OID Default
If the OID has a Default Value associated with it, that Default Value must be entered here. This will cause the OID to be created with the Default Value.

This is only a default value and if the Access Type allows, this value can be changed.

OID Description
This is a free format text field that allows entry of a textual Description of the function, allowable values etc. for the OID. It is for information purposes only.
Resequence Master Tables

Before you edit a newly created or expanded Master Table, you should re-sequence that Master Table. This will re-sort the Master Table in the correct sequence, ensuring that instantiated OIDs are correctly grouped together.

Select Table
If you assemble or expand a Master Table, you should always resequence that table before attempting to edit it. This utility will re-sequence the table into OID Number sequence.

Select the table that is to be resequenced from the drop down list box.

Max Count OID Indent
This is a read only field and displays the maximum number of indent levels for the selected table. When a Master Table is resequenced, the system scans the entire table to find this value and uses it in the sorting process.

Record Count Re-sequenced
Once the table has been re-sequenced, the total number of records in the table will be displayed here for information purposes.

Re-sequence OIDs
Click on this button to re-sequence the OIDs in the selected Master Table.
Dynamic Message Sign Simulator

Select Device To Simulate
Select the device that is being tested from the drop-down list. If the device that you are testing does not appear in this list, that device will have to be added.

When the device is selected, the Device Type Name, Connection Type, Device Address and the Description for that device will be displayed. The values for these fields cannot be edited here. To change any of these details go to the Create, Edit or Delete Device option. Access this by selecting Devices from the Device option on the Main Menu.

Activity
This field displays the status of the last communication event. If the entire line of commentary does not display in the window, highlight that line and select Zoom from the Tools Menu.

Current Device Time
If the selected Device supports global time object, the time stored in the database will be displayed in this field.

Current Device Time (Raw)
This value represents the NTCIP Time - number of seconds since 1970.

Current Device MULTI Message
This is the MULTI Message that the device is currently displaying.
(dmsMessageMULTIString.5.1).
**Current Message Activation Time**
This is the message activation time which has been extracted from the first 2 bytes of dmsMessageActivationCode.0 Object.

**Current Message Activation Priority**
This is the message activation priority which has been extracted from the 3rd byte of dmsMessageActivationCode.0 Object.

**Current Message Display Time Remaining**
This represents the value of the DMS Message time remaining object - decreased once per minute.

**Current Message Activation Source**
This represents the memory type and message number of the currently activated message.

**NTCIP Time Calculator**

The NTCIP Time calculator is a facility that converts the time in standard Microsoft format to NTCIP format and vice versa.

By default, the current time will be displayed when the form is opened.

To convert NTCIP time to Microsoft time, enter the NTCIP time and click on the Convert NTCIP time To Microsoft Time button. The corresponding Microsoft time will be displayed in the Microsoft Time field.

To convert Microsoft Time to NTCIP Time, enter the Microsoft Time and click on the Convert Microsoft to NTCIP Time button. The NTCIP time will be displayed in the NTCIP Time field.

Use the standard copy (Ctrl C) and paste (Ctrl V) functions to transfer these values to a test value.
Help

The Help menu allows you to access the Help file and provides details about the version of DeviceTester that you are running. Help is accessible from each field in DeviceTester. You can also open it using the Help menu item.

To access Help from the individual fields in DeviceTester, place the cursor in the field and press F1. Alternatively, place the cursor in the field, right click the mouse, and then click on the “What’s This?” window that opens.

DeviceTester Help

This will open the Help File so that you can search for help on a specific topic. Search for a topic using the Contents, Index or Find functions.

About DeviceTester

Clicking on the About DeviceTester will provide details of the current version that is installed.
DeviceTester For NTCIP

Version 1.80
Intelligent Devices, Inc.
2405 Satellite Blvd, Suite 212
Dublin, GA 30035
U.S.A. All rights reserved.

Acknowledgements
Byron Mulligan    Rieen Slauder
Barbi Willis      Red Seto
Kevin J. Lewis    Lisa Meeks
Andrew Conlin

Warning: This computer program is protected by copyright law
and international treaties. Unauthorized reproduction or
distribution of this program, or any portion of it, may result in
severe civil and criminal penalties, and will be prosecuted to
the maximum extent possible under the law.
HOW TO IMPORT A MIB INTO DEVICETESTER

To import a MIB in ASN.1 format into a Device Tester master table follow these steps:

1) Since the SMIC compiler is a DOS utility, your MIB file name must be in DOS 8.3 format. If it is not, rename the file to maximum 8 characters (no spaces) with the 3 character extension “.mib”.

2) Copy the MIB to the DeviceTester support files directory (if you installed DeviceTester to the default directory, it will be C:\Program Files\DeviceTesterForNtcip\SupportFiles).

3) Select the menu option Tools / Import MIBS... to open the Master Table Builder.

4) Select standard MIB files to include. You will almost always need the first three “rfc” MIBs. If your MIB includes objects under the NEMA private branch then you will need the first five MIB files. Uncheck any MIB files you do not want included in your Master Table.

5) Add your MIB file name to the list. In the entry record of the on screen table (the last record, which begins with “* 0”), enter:
   a. A unique MibID, which should be the next sequential number following the one above
   b. The MIB file name
   c. MibFileSelected checked
   d. An optional description

6) Enter a name for the master table in the “Enter or Select Master Table Name” box. It does not have to begin with OID_, but all the included master tables do.
7) Click on the “Create Master Table” button.

8) If you get a message that there were errors, examine the OUTPUT.TXT file (in the same Support Files directory where you placed the MIB). Correct any problems in the MIB and try “Create Master Table” again.

The SMIC MIB Compiler does have a size limitation. A compile failure may indicate that you have exceeded that limit. If this happens, you will need to deselect one or more of the MIBs that you had selected and compile with fewer MIBs or maybe even split your MIB into two or more parts. You can then create Master Tables for each part, and use the Master Table Assembler to merge them into one “master” Master Table.

9) The compiler often generates empty records which must be removed from the Master Table. So next click on “Go Assemble Master Table”.

Figure 2. Information to build OID_VMSUTMC added
10) In the Master Table Assembler, first select a “Source Master Table” in the upper left pull down menu. Select any master table, it does not matter which since we will not actually be modifying it.

11) For “Target Master Table” select your new master table. If there are any empty rows in the display, select them and then click on the “Delete Selected” button.

12) Once there are no more empty rows, click on “Go Resequence Master Table Before Use”.

13) In Master Table Resequence select your new master table in the pull down menu, then click on the “Resequence OID’s” button. A warning will pop up that any device data that uses this table will be lost, click OK.

Your master table is now ready to use. To create a device that uses the new table:

1) From the main menu bar select Device / Device Types…, then click “New”. Select your new master table as the “Device Type Master Table” and enter a name and description for your new device type.

2) From the main menu bar select Device / Devices…, then fill in the upper “Create Device” section. Select your new device type as “Device Type Name”, select a connection, and enter a device name and description. For serial connections enter the device address; for Ethernet connections that do not use the CDPD option enter a zero for the device address.

You can now use this new device in EasyTest, ScriptBuilder and other DeviceTester functions.
### INDEX

<table>
<thead>
<tr>
<th>Item</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>About DeviceTester</td>
<td>56</td>
</tr>
<tr>
<td>Activity</td>
<td>16, 20, 27, 53</td>
</tr>
<tr>
<td>Advanced Test</td>
<td>24</td>
</tr>
<tr>
<td>Apply Value</td>
<td>27</td>
</tr>
<tr>
<td>Auto Test Configuration</td>
<td>40</td>
</tr>
<tr>
<td>Backup Tables</td>
<td>9</td>
</tr>
<tr>
<td>Communication Status</td>
<td>15, 26</td>
</tr>
<tr>
<td>Community</td>
<td>14, 18</td>
</tr>
<tr>
<td>Conformance Group</td>
<td>44</td>
</tr>
<tr>
<td>Conformance Group Items</td>
<td>43</td>
</tr>
<tr>
<td>Conformance Group Name</td>
<td>43</td>
</tr>
<tr>
<td>Conformance Groups</td>
<td>43</td>
</tr>
<tr>
<td>Conformance Item ID</td>
<td>44</td>
</tr>
<tr>
<td>Connection</td>
<td>34, 35</td>
</tr>
<tr>
<td>Connection Description</td>
<td>37</td>
</tr>
<tr>
<td>Connection Name</td>
<td>37</td>
</tr>
<tr>
<td>Connection Type</td>
<td>37</td>
</tr>
<tr>
<td>Connections</td>
<td>37</td>
</tr>
<tr>
<td>Create Device</td>
<td>32</td>
</tr>
<tr>
<td>Create Master Table</td>
<td>45</td>
</tr>
<tr>
<td>Create New Instances</td>
<td>46</td>
</tr>
<tr>
<td>Current Device MULTI Message</td>
<td>53</td>
</tr>
<tr>
<td>Current Device Time</td>
<td>53</td>
</tr>
<tr>
<td>Current Device Time (Raw)</td>
<td>53</td>
</tr>
<tr>
<td>Current Message Activation Priority</td>
<td>54</td>
</tr>
<tr>
<td>Current Message Activation Source</td>
<td>54</td>
</tr>
<tr>
<td>Current Message Display Time Remaining</td>
<td>54</td>
</tr>
<tr>
<td>Delete Device</td>
<td>34</td>
</tr>
<tr>
<td>Delete Device Name</td>
<td>34</td>
</tr>
<tr>
<td>Delete Master Table</td>
<td>45</td>
</tr>
<tr>
<td>Description</td>
<td>22</td>
</tr>
<tr>
<td>Device</td>
<td>12</td>
</tr>
<tr>
<td>Device Address</td>
<td>34, 35</td>
</tr>
<tr>
<td>Device Description</td>
<td>34, 35</td>
</tr>
<tr>
<td>Device Name</td>
<td>34, 35</td>
</tr>
<tr>
<td>Device Number</td>
<td>34</td>
</tr>
<tr>
<td>Device Type Description</td>
<td>36</td>
</tr>
<tr>
<td>Device Type Master Table</td>
<td>36</td>
</tr>
<tr>
<td>Device Type Name</td>
<td>34, 35, 36</td>
</tr>
<tr>
<td>Device Types</td>
<td>36</td>
</tr>
<tr>
<td>Devices</td>
<td>31</td>
</tr>
<tr>
<td>DeviceTester Help</td>
<td>55</td>
</tr>
<tr>
<td>Dynamic Message Sign Simulator</td>
<td>53</td>
</tr>
<tr>
<td>Easy Test</td>
<td>12</td>
</tr>
<tr>
<td>Edit Device</td>
<td>35</td>
</tr>
<tr>
<td>Edit Master Tables</td>
<td>48</td>
</tr>
<tr>
<td>Enter Or Select Master Table Name</td>
<td>45</td>
</tr>
<tr>
<td>Entry For</td>
<td>48</td>
</tr>
<tr>
<td>Exit</td>
<td>11</td>
</tr>
<tr>
<td>Expand Master Table</td>
<td>47</td>
</tr>
<tr>
<td>Expand Master Tables</td>
<td>45</td>
</tr>
<tr>
<td>Exports</td>
<td>7</td>
</tr>
<tr>
<td>File</td>
<td>6</td>
</tr>
<tr>
<td>Filter By</td>
<td>47</td>
</tr>
<tr>
<td>FSOR</td>
<td>30</td>
</tr>
<tr>
<td>Get From Database</td>
<td>17, 26</td>
</tr>
<tr>
<td>Get From Device</td>
<td>17, 26</td>
</tr>
<tr>
<td>Group Address</td>
<td>25</td>
</tr>
<tr>
<td>Help</td>
<td>55</td>
</tr>
<tr>
<td>Import MIBs</td>
<td>44</td>
</tr>
<tr>
<td>Import Scripts</td>
<td>9</td>
</tr>
<tr>
<td>Installing DeviceTester</td>
<td>4</td>
</tr>
<tr>
<td>Instances</td>
<td>46</td>
</tr>
<tr>
<td>Introducing DeviceTester</td>
<td>3</td>
</tr>
<tr>
<td>Item Objects</td>
<td>46</td>
</tr>
<tr>
<td>Line Number</td>
<td>20</td>
</tr>
<tr>
<td>Log Configuration</td>
<td>41</td>
</tr>
<tr>
<td>Main Menu Bar Functions</td>
<td>6</td>
</tr>
<tr>
<td>Make Master Tables</td>
<td>47</td>
</tr>
<tr>
<td>Master Table Name For Objects</td>
<td>43</td>
</tr>
<tr>
<td>Max Count OID Indent</td>
<td>52</td>
</tr>
<tr>
<td>Navigate Scripts</td>
<td>19, 23</td>
</tr>
<tr>
<td>NTCIP Time Calculator</td>
<td>54</td>
</tr>
<tr>
<td>Object Access</td>
<td>51</td>
</tr>
<tr>
<td>Object Model</td>
<td>33</td>
</tr>
<tr>
<td>Object Status</td>
<td>51</td>
</tr>
<tr>
<td>Object Syntax</td>
<td>50</td>
</tr>
<tr>
<td>Object Type</td>
<td>49</td>
</tr>
<tr>
<td>OID</td>
<td>48</td>
</tr>
<tr>
<td>OID Default</td>
<td>48</td>
</tr>
<tr>
<td>OID Description</td>
<td>51</td>
</tr>
<tr>
<td>OID Instance</td>
<td>49</td>
</tr>
<tr>
<td>OID Maximum</td>
<td>51</td>
</tr>
<tr>
<td>OID Minimum</td>
<td>50</td>
</tr>
<tr>
<td>OID Name</td>
<td>49</td>
</tr>
<tr>
<td>OID Title</td>
<td>49</td>
</tr>
<tr>
<td>Options</td>
<td>17, 19, 27</td>
</tr>
<tr>
<td>Record Count Resequenced</td>
<td>52</td>
</tr>
<tr>
<td>Record Of Items</td>
<td>46</td>
</tr>
<tr>
<td>Record Of Scripts</td>
<td>20, 23</td>
</tr>
<tr>
<td>Reports</td>
<td>6</td>
</tr>
<tr>
<td>Resequence Master Tables</td>
<td>52</td>
</tr>
<tr>
<td>Resequence OIDs</td>
<td>52</td>
</tr>
<tr>
<td>Restore Tables</td>
<td>10</td>
</tr>
<tr>
<td>Run Script</td>
<td>18</td>
</tr>
<tr>
<td>Script Builder</td>
<td>18</td>
</tr>
<tr>
<td>Script Description</td>
<td>19</td>
</tr>
<tr>
<td>Script Detail</td>
<td>20</td>
</tr>
<tr>
<td>Script Name</td>
<td>19</td>
</tr>
<tr>
<td>Script Number</td>
<td>19</td>
</tr>
<tr>
<td>Select Conformance Item Name</td>
<td>44</td>
</tr>
<tr>
<td>Select Device</td>
<td>18</td>
</tr>
<tr>
<td>Select Device To Simulate</td>
<td>53</td>
</tr>
<tr>
<td>Select Device To Test</td>
<td>13, 24</td>
</tr>
<tr>
<td>Select Function</td>
<td>20</td>
</tr>
<tr>
<td>Select Master Table Name</td>
<td>46</td>
</tr>
<tr>
<td>Select Table</td>
<td>52</td>
</tr>
<tr>
<td>Selected Instance Objects</td>
<td>27</td>
</tr>
<tr>
<td>Set To Database</td>
<td>17, 26</td>
</tr>
<tr>
<td>Set To Device</td>
<td>17, 26</td>
</tr>
<tr>
<td>Single Step</td>
<td>19</td>
</tr>
<tr>
<td>DeviceTester</td>
<td>INDEX</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>Sort By OID</td>
<td>27</td>
</tr>
<tr>
<td>Source Master Table</td>
<td>47</td>
</tr>
<tr>
<td>Source OID As</td>
<td>26</td>
</tr>
<tr>
<td>Specification</td>
<td>43</td>
</tr>
<tr>
<td>Start Auto Test</td>
<td>16</td>
</tr>
<tr>
<td>Starting DeviceTester</td>
<td>5</td>
</tr>
<tr>
<td>Status</td>
<td>46</td>
</tr>
<tr>
<td>STMP and SFMP</td>
<td>27</td>
</tr>
<tr>
<td>Stop Auto Test</td>
<td>16</td>
</tr>
<tr>
<td>Stop Script</td>
<td>19</td>
</tr>
<tr>
<td>Syntax Specific</td>
<td>49</td>
</tr>
<tr>
<td>Target Master Table</td>
<td>47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>42</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Defaults</td>
<td>42</td>
</tr>
<tr>
<td>Test Name</td>
<td>16, 27</td>
</tr>
<tr>
<td>Test Number</td>
<td>16, 19, 27</td>
</tr>
<tr>
<td>Test Options</td>
<td>40</td>
</tr>
<tr>
<td>Test Witness</td>
<td>16, 19, 27</td>
</tr>
<tr>
<td>Time Out</td>
<td>39</td>
</tr>
<tr>
<td>Tools</td>
<td>40</td>
</tr>
<tr>
<td>Total Source Objects</td>
<td>47</td>
</tr>
<tr>
<td>Total Target Objects</td>
<td>47</td>
</tr>
<tr>
<td>Transport Type</td>
<td>39</td>
</tr>
<tr>
<td>Value</td>
<td>16</td>
</tr>
<tr>
<td>Zoom</td>
<td>40</td>
</tr>
</tbody>
</table>